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ACCESSORIES AND COMPONENTS 
 
 
 

Check packaging and ensure the following standard items are included 
 

• PC-Vet wireless monitor 

• ECG chest probe for small animals 

• Three lead skin clips 

• Spray bottle with electrolyte 

• Bluetooth adaptor 

• PC-Display install CD 

• Vinyl storage pouch 
 
The following optional items are available 
 

• ECG interpretation software install CD 

• Yoke cable for long term monitoring leads 

• Three long term monitoring leads with clips 

• PET4 esophageal ECG and temperature probe for  kittens, small puppies and exotics 

• PET6 esophageal ECG and temperature probe for cats and small dogs 

• PET8 esophageal ECG and temperature probe for larger breads 

• ECG chest probe for horses and other large animals 
 



PRECAUTIONS 
 

� DO NOT PLUG PC-VET SENSORS INTO ANY OTHER EQUIPMENT 
OR INTO AC LINE RECEPTICALES 

� PC-VET IS NOT REGISTERED WITH THE FDA FOR HUMAN USE. 

� Do not use in the presence of flammable anesthetics. 

� Do not immerse the PC-Vet, sensors or cables in water or other fluids.  Avoid 
spilling any fluids on the PC-Vet or accessories.  Review Service and Maintenance 
Chapter for proper cleaning procedures.   

� Do not gas sterilize or autoclave the PC-Vet or sensors. 

� Do not disassemble. The PC-Vet contains no operator serviceable components. 

� Electrical Interference:  Strong electromagnetic or radio frequency interference 
(RFI) may affect the performance of all ECG equipment including the PC-Vet. 
RFI may result in distorted ECG signals.  Do not operate near electro-cautery or 
diathermy equipment.  Radio frequency cautery equipment does not interfere 
with the ECG signal. Dental scaling devices will interfere with the ECG signal 
particularly on smaller patients.  Use of esophageal probes minimizes scaler 
interference.  

� Conductive parts such as electrodes and associated connectors and clip leads, 
including the neutral electrode, should not contact other conductive parts 
including ground when using the PC-Vet. 

� Ensure that electrodes are connected only to the patient and do not touch any 
other conductive part or equipment to prevent possible shock to patient from 
leakage current. 

� Avoid cable and connector damage by taking care when connecting and 
disconnecting sensors and leads from the PC-Vet.  Grasp plug, not the cable and 
pull straight out and push straight in.   

� Do not pull clip leads from the patient without opening clip.  
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Chapter 1     Installation and Setup 

DO NOT INSTALL THE BLUETOOTH SOFTWARE.  FOLLOW THE 
BLUETOOTH INSTRUCTIONS IN THIS MANUAL.  NOTE: This printed 
manual covers Bluetooth installation on Windows Vista and Windows XP with 
Service Pack 2 or 3 (SP2 or SP3) computers only.  Refer to the manuals included 
on the Vmed Installation CD or to the included installation tutorial videos to 
setup Bluetooth on computers using earlier operating systems.  

 

Installing the PC-Display Application software 
 

1. Put the Vmed Software Installation CD into the computer’s CD-ROM drive.  The 
installation program should automatically start and the window below will appear:  

 

 
 

NOTE: You may at first wish to click the “Play suggested installation 
tutorial video” text in order to view a tutorial video of how to install 
Bluetooth and discover your Vmed wireless device on your computer. 

 

Chapter 

1 
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NOTE:  If you wish to save printed reports with ECG sweep information to 
a PDF (Acrobat) file then you should choose to install Primo PDF from the 
“Other Software” link of the main installer screen.  You should also install 
the ECG Reviewer from this main screen if you already do not have the 
ECG Interpreter installed. 

 
2.  Click “Install PC-Display”.  The following screen will appear. 
 

 
 
3. Click Next. 
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4.  Click “Yes” and the following window should appear: 
       

 
 
 

5.  Choose “I Agree” and click “Next” 
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6.  Click “Close” to complete 

7.  Continue installing successive programs then remove the installation CD.  
 

NOTE:  Shortcuts to the PC-Display and PC-Display DEMO programs will 
be placed on the Windows desktop and in the Programs folder of the Start 
menu.  Icons for other wireless monitors, if installed, will also be placed on 
the desktop.  It is now recommended that you use PC-Display to connect to 
all Vmed wireless remotes. 

 

Installing Bluetooth  
 

IF YOUR COMPUTER HAS A PRE-INSTALLED OR INTERNAL BLUETOOTH 
DEVICE, DO NOT INSTALL THE BLUETOOTH ADAPTOR SOFTWARE OR THE 
INCLUDED BLUETOOTH ADAPTER. CONTACT YOUR VMED VENDOR FOR 
TECHNICAL ASSISTANCE. 

 
IF YOUR COMPUTER USES THE WINDOWS VISTA OR XP OPERATING SYSTEM 
WITH SP2 OR SP3 INSTALLLED, DO NOT INSTALL THE BLUETOOTH ADAPTOR 
SOFTWARE.  NOTE:  Vmed recommends using a Windows Vista or XP (SP2 or SP3) 
computer since it is much easier to set up and use Bluetooth and to display multiple patients on 
one computer if the Windows Bluetooth drivers are used.   
 
IF YOU HAVE PREVIOUSLY INSTALLED THE BLUETOOTH SOFTWARE, 
UNINSTALL IT; RE-BOOT YOUR COMPUTERAND CALL THE VENDOR FROM 
WHOM YOU BOUGHT THE PC-VET FOR TECHNICAL ASSISTANCE. 
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Bluetooth Installation and Discovery, Windows XP Service Pack 2  
 
1. Plug the Bluetooth USB adaptor (Dongle) into a USB port on your computer. 

 
2. Windows should automatically detect the device and respond with an audio prompt.  
A note confirming detection of the device should appear in the lower right hand 
corner of the display. 

 

 
 

3. Double click the “Bluetooth Devices” icon on your desktop or select “Bluetooth 
Devices” from the “Control Panel” or from the “Start” menu. 

 
 
 

 
4. After the following “Bluetooth Devices” window appears click on the button marked 
“Add”. 

 

 
  

 

5. The following window should appear:   
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6. Turn on your PC-Vet by depressing the red button at the top left of 
the PC-Vet module’s keypad.  

 
7. Wait for the “STATUS” light on the PC-Vet to turn amber and then put a check mark 
next to “My device is set up and ready to be found.” on the Add Bluetooth Device 
Wizard window. 

 
     8. Click “Next” and your computer will search for the PC-Vet.  When the PC-Vet is 

discovered, a window like the one below will appear. The serial number following 
“Vmed-ET” will be the same as the serial number that is printed on the back label of 
the PC-Vet.   
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9.  Highlight the identified PC-Vet and click “Next”, which will open the following window: 

               

10.  Select the “Don’t use a passkey” button and click “Next”. When the window below 
opens, click “Finish”.   

 
NOTE:  There should be two COM (Communications) ports listed on this 
window.  They may be different for different discoveries and you should not 
have to remember them but you should verify that there are two listed.  
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Using the PC-Vet with Windows Vista or XP Service Pack 2 or 3 
 

1. Power on the previously discovered PC-Vet.  The “STATUS” light on the PC-Vet 
will turn red and then yellow.  NOTE:  Every device has to be discovered once 
for each PC. If you have never been through the discovery procedure with 
this particular device on this PC, do so before proceeding.  See the previous 
section for instructions. 

 
2. Double-click the PC-Display icon on the desktop to open the window below: 

 
 

 
 

 
3. Select the device you wish to use in the drop-down window and click “Connect”. 

NOTE:  If you have discovered multiple wireless monitors, the device last 
discovered or connected to your computer will appear in the text box in the 
above window.  Press the “down” arrow to view the other discovered 
devices and highlight the one you want to use before connecting. As many 
as eight wireless devices can be connected to a computer at one time.  The 
practical limitation, however, is the size of the display and the computing 
power of your computer.  To use multiple devices, go to step #1 and repeat 
the discovery process for each. The Vmed software automatically selects the 
COM Port if Windows XP (SP2 or SP3) is installed. 
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4.  Once the wireless monitor has been selected from the list and you press the 
“Connect” button then PC-Display should automatically connect to the device.  It 
might take a few seconds for PC-Display to initially discover the different sensors 
that are attached to your wireless monitor.  Once it has done so it will repaint the 
screen with the appropriate measurements displayed.  (See “Setup PC-Display 
Defaults” of chapter 1 and all of chapters 2 and 3 for more information about the 
use of PC-Display) 

 
 

Setup PC-Display Defaults 
This section describes the procedure to change the default settings that will apply each time 
the PC-Display program is opened. Feature default settings such as TONE, ALARM, 
ON/OFF, GRID, etc. may be overridden by clicking the applicable icon on the upper 
toolbar only if the PC-Vet is connected to your computer.  

NOTE:  The “Edit Default Configuration” will set the defaults for each time a 
wireless monitor is connected to PC-Display.  If you wish to quickly make 
changes for the currently connected session only, you can click on the “Edit 
Current Configuration” toolbar button on the Windows display (Icon looks like a 
gear). However, whatever changes you make using the Current Configuration will 
only be effective for the current connection and not change the “Edit Default” 
settings. 

 

 

 

Figure 1:  Edit Current Configuration Icon on PC-Display upper toolbar 
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1. Double click the PC-Display icon on your desktop. The following window will 
open: 

         

 
 

2. Click the “Cancel” button on the “Select Wireless Remote Connection” window. 
 

3. Click the “File” menu and confirm that there is no check mark next to the “Connect 
Wireless Remote…” option.  NOTE:  This allows access to the “Tools” menu.  

 
4. Click “Tools” > “Edit Default Configuration…” and the following dialog box will 
open: 
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Figure 2:  PC-Vet “Edit Default Configuration” menu.   

NOTE:  Some selections in the Default Configuration menu apply only to the 
PC-VetGard+ surgical monitor and can be ignored. 

5. SPECIFY COM PORT NUMBER: Will not be checked for Vista or XP Service 
Pack 2 or 3 computers.  The appropriate COM port number should be entered here 
for non-Vista/XP (SP2 or SP3) computers only. Refer to (“Setup of the Bluetooth 
Adaptor”) in the  non-Vista/XP (SP2 or SP3) section of the manual on the CD.  

6. SPECIES:  Select most common patient seen. 

7. ECG SWEEP RATE (Chart speed): Use a sweep speed of 50 mm/sec. for 
diagnostics and 25 mm/sec for surgery. 

8. RR/CO2/O2 SWEEP RATE:  Applies to PC-VetGard+ patient monitor only. 
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9. ECG FEATURES:  Select the ECG features you wish to display. 

• R Wave Marker:  Places a triangle mark over the R wave on display  

• QRS TONE:  Provides an audio beep tone with each beat. 

• 5 mm REFERENCE GRID:  Displays a grid under ECG trace for visual reference 
of QRS amplitude. 

• HR>400 BPM:  Choose this selection to accurately record heart rates up to 800 
BPM. (leave this unchecked for lower heart rates). 

• ECG NOTCH FILTER: Use filter AC line interference. For North America and 
Canada, use 60 Hz. For most other countries choose 50 Hz. 

• ECG LOW PASS FILTER:  The default setting is “LOW”.  Select “HIGH” filter 
if noise is excessive. 

• PATIENT EPISODE RECORDING MODE:  This selection applies to 
automatic recording of information when certain events occur such as “alarm” or 
“print”.  If “Continuous Event Only” is selected, only vital signs are automatically 
recorded and this is the preferred selection for patient monitoring. The other 
selection allows the automatic capture of the ECG waveform with each event 
which is the preferred selection for diagnostic ECG. 

NOTE: Whenever recordings are manually initiated from the “Toggle 
Continuous ECG” icon on the toolbar, ECG sweep will always be recorded 
even if the default selection is “Continuous Event Only”. 

• AUTO SAVE:  This will automatically cause the recording of ECG waveforms 
and any other events once the PC-Vet is connected to PC-Display. 

• PATIENT EPISODE DIRECTORY:  The default file storage directory is named 
“Vmed_Patient_Episodes” within the user’s “My   Documents” folder.  Choose  
“Select Directory” to change  the stored files location. 

• PRINT REPORT: Choose the desired number of pages for the print report.  
Select two pages to display both ECG trace and table of vital signs. 

• EPISODE REVIEWER:  this allows you to select the program to display and 
review stored files.  If Interpreter is installed, choose this setting since Interpreter 
also includes all the features present in Reviewer.  

• WAVEFORMS:  This selection applies to PC-VetGard+ only. 
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• ALARM SETTINGS:  Selects how alarms are presented either with audio alarm, 
visual display or both.  Alarms can be silenced from the active PC-Display screen.  

• AUTOMATIC TREND GRAPH:  Choose the time interval that you prefer the 
trend graph to be automatically displayed throughout the procedure. When “OFF”, 
the trend graph can only be displayed when selected on the upper tool bar.  

10.   Select the “ECG, Temperature” tab to change default heart rate and temperature   
alarm settings for each species.  You may also choose whether the temperature will 
be displayed as Celsius or Fahrenheit.   

NOTE:  The temperature portion of the menu only applies if an esophageal 
probe is  used. 

 

  Figure 3:  ECG, Temperature selection menu. 
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Setup Vet/Clinic Information USA and Canada 
 

1. Click the “Tools” menu on the upper tool bar of the  PC-Display and then 
“Edit Vet Information” and the following window will appear:   

 

  
 

2. Type in your vet/clinic information as above.   

NOTE: Your entries will be remembered each time the program is 
started and contains text that will be printed on the ECG print report and 
all Reviewer generated reports. 

3. Press OK.  NOTE:  Refer to the instructions below if you wish to add 
your clinic logo to the report heading. 
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Setup Vet/Clinic Information International 
 

The “Edit Vet Information” box as shown below has a pull down menu selection for 
state. All U.S. and Canadian States and Territories should be listed. If your clinic is not 
within one of these state selections, then select the entry which shows a blank. Use 
the other available entry boxes to fill in the specifics of your address.  

 
1.  Click the “Tools” menu on the upper tool bar of the Windows display and then 
“Edit Vet Information” and the following window will appear: 

 
 

 
 
 
 

2.  Type in your vet/clinic information as above.   

NOTE: Your entries will be remembered each time the program is started 
and contains text that will be printed on the ECG print report and all 
Reviewer generated reports. 

3. Press OK.   

NOTE:  Refer to the instructions below if you wish to add your clinic logo 
to the report heading 
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Using Your Clinic Logo on Printed Reports 
 

The default logo provided in the ECG report printout is shown below; 

 
 

To customize a logo specific to your clinic, follow the procedure below: 
 

 
1. Click on the desktop ‘My Computer’ icon and navigate to the installation 
directory for PC-Display. For most users this will be ‘C:\Program Files\Vmed 
Technology\PC-Display’  The screen below will appear: 
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NOTE: You may need to turn on the file extensions first by clicking on the 
“Tools” menu of this Explorer window and then selecting “Folder 
Options…”.  Choose the “View” tab from the Folder Options window and 
then remove the checkmark next to “Hide extensions for known file types” 
within the Advanced settings box. 
 

 
 

2. Select the file ‘logo.bmp’ and then right click the mouse and select “Copy”, 
then right click again and select “Paste”. 

 
3. A file called ‘Copy of logo.bmp’ will be created. Right click on this new file and 
choose ‘Rename’ then rename the file to ‘customlogo.bmp’. 

 
4. The image in this file will now appear on the printouts from PC-Display. Edit 
the file to create your own custom logo. The following constraints must be 
observed. 

 
�   The file must be named ‘customlogo.bmp’ 
�   Any size image can be used, but it will be stretched or compressed to 1024 

by 512 pixels in the printout.  
�   Best results are achieved when image file is 1024 by 512. 
�   The image must be in .bmp format 24 bit color. 
�   Any photo editor can be used to create a custom logo. Most computers 

will at least have PC-Paint. If you have a logo as part of the header in a 
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Word document it can be cut and then pasted into PC-Paint, resized and 
then saved. 

�   Vmed software upgrades will overwrite the original ‘logo.bmp’ file but will 
leave the ‘customlogo.bmp’ file untouched. Software upgrades should not 
affect the new logo. 

 
NOTE:  The ‘Print Preview’ function in PC-Display can be used to see 
how the new logo will look on the printout. An example is shown below. 

 

 
 
   

    
    

Figure 4  Sample print reports with customized clinic logo.  

NOTE: Veterinary information changed by using the “Tools”> ‘Edit 
Vet Information…’ menu. 
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     Setup Patient Information 
NOTE: You may elect to enter patient information after completing the 
monitoring procedure if desired. This information may also be edited in the 
Reviewer Program. Vmed recommends at least entering a patient’s name or 
ID in the “Patient Name” box prior to monitoring in order to make it easier 
to locate later on. 

 
1. Select the “Tools” on the upper tool bar and then “Edit Patient Information”.  
The following window will appear: 

 

2. Type in desired information and press OK.  

 

NOTE:  This window will automatically appear when connecting to a 
wireless remote or after selecting “New Patient…” from the File menu. 
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Customization of the Patient Information List 
  
Species and Breeds available in the dropdown menu above are user customizable using 
the following procedure (the use of Microsoft Excel is recommended for best results): 

1. Verify that your computer has Microsoft Excel installed properly. 

2. Click on the desktop ‘My Computer’ icon and navigate to the installation directory 
for PC-Display. For most users this will be ‘C:\Program Files\Vmed 
Technology\PC-Display’. 

3. Select the file ‘Species&Breeds.xls’ and then right click the mouse and select 
“Copy”, then right click again in the white space of the window and select “Paste” 

4. A file called ‘Copy of Species&Breeds.xls’ will be created. Right click on this new 
file and choose ‘Rename’ then rename the file to ‘CustomSpecies&Breeds.xls’ 

5. Double click on “CustomSpecies&Breeds.xls”. Excel should open it as shown 
below: 
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6. The spreadsheet can be edited to add species and breeds as desired. The following 
restrictions apply:  

� Entry A1 must remain “Species” and B1 “Breed”. 

� The total number of characters per spreadsheet line (Species and Breed) 
must be less than 60 

� There can be no more than 25 different kinds of species 

� There can be no more than 500 breeds per species. 

� There can be no more than 2000 total entries in the spreadsheet. 

� Do not enter data in any columns except A and B 

7. Save the edited spreadsheet. 

8. Use Excel’s “Save As” feature to save the spreadsheet as tab delimited text. The 
saved filename should be “CustomSpecies&Breeds.txt”. This file is read by 
PC-Display to generate the species and breeds dropdown menus in the patient 
information dialog. 

 

Computer Video Resolution  
 
PC-Display works best when the video resolution on your computer display is set to 1024 
x 768 so that the entire PC-Display display is viewable. Select Start > Settings > Control 
Panel > Display > Settings 
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Chapter 2     Monitor Description 

 

Hardware 
The PC-Vet is a battery operated, Bluetooth enabled, wireless, ECG monitor equipped to 
provide Lead II information for the detection of rhythm and conduction abnormalities of the 
animal heart.  ECG signals are detected using four types of sensors.  Clip leads and disposable 
chest electrodes plug into the PC-Vet cable receptacle.  

1. A chest probe with three built-in metallic electrodes placed so that when positioned 
over the heart, as described, accurate rate and rhythm information is derived. 

2. A set of three clip electrodes that, when attached to the legs of the patient as 
described, provide Lead II information. 

Note:  Since it is not always possible to obtain an adequate signal using the 
chest probe, clip leads may be required when monitoring some patients.  Clip 
leads can also be used to continuously monitor the ECG signal during surgery 
or for short term critical care monitoring. 

3. A set of three optional internal esophageal probes are available.  These probes offer a 
convenient and superior method of monitoring heart rate, heart rhythm and core 
temperature of the anesthetized patient. Use of an esophageal probe will reduce or 
eliminate noise generated by dental scaling devices.  Three electrodes are affixed to a 
flexible plastic tube that is inserted into the esophagus and positioned over the heart 
with the distal electrode positioned behind the left ventricle and the second electrode 
behind the left atrium.  The third electrode is ground.  

4. An optional three lead yoke cable and set of 3 leads with disposable electrode clips.  
This sensor is used for long term monitoring. 

 

 

 

Chapter 
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 25252525    

 
The PC-Vet is equipped with an integral wireless Bluetooth radio transmitter. Bluetooth 
enables the wireless transmission of  information, including real-time ECG signals, 
between the PC-Vet and a Bluetooth enabled Windows based computer.  The PC-Vet is 
designed to control computer and ECG functions without leaving the patient.  
Commands, including the print command, can be activated from the PC-Vet keypad, 
however data that must be entered with a keyboard such as clinic and patient 
information, cannot be entered from the key pad.  
 
Commands can be activated from the PC-Vet keypad or the PC-Display upper toolbar on 
the computer.  PC-Display  toolbar icons are active only if  a wireless connection between 
the PC-Vet and the computer is established.  
 
Bluetooth operates at approximately 2.4 GHz and steps up and down frequency 
constantly making the PC-Vet free of interference, including the radio frequency 
interference found in hospital and clinic settings.  Bluetooth transmissions are omni- 
directional, operate at low power and travel through walls and around corners to a radius 
of 50-100 ft. within the clinic.  It is not necessary to aim the PC-Vet at the computer or 
printer to initiate the print function. The computer and/or printer can be in another 
room if desired.  Any printer connected to your computer may be used, however the 
color ECG grid will print in black unless a color printer is used.  
 
Power is supplied by two AA alkaline batteries.  Batteries will last for about 50 hours of 
continuous use.  Battery life increases markedly by substituting long-life type AA 
batteries.  Rechargeable AA batteries may also be used however a charger is not available 
through Vmed. Refer to the maintenance instructions at back of this manual for battery 
changing instructions. 
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PC-Vet Keypad Controls 
ON/OFF SWITCH:    Press and immediately release to turn ON; press and hold down to turn 
OFF.  The PC-Vet will shut off automatically if a computer wireless connection is not 
established within three minutes.  

UP/DOWN ARROWS:   Scroll through the various menus available with the SELECT 
switch.  Press the SELECT again after scrolling to the desired selection. 
 

 
 
SELECT SWITCH:   Connects to most icons on the display 
tool bar and allows the remote selection of options such 
as SPECIES, SWEEP SPEED, ALARMS, TONE, 
SCALE, GRID, etc. 
 

EVENT MARK SWITCH:    Places an orange reference mark on the 
display and print copy to mark an event or point of interest. 
 
STOP/START SWITCH:   Freezes and re-starts the ECG sweep on 
the display.  This button has nothing to do with ECG recording. 
 

PRINT:   Sends information on the screen to the printer that is 
connected to the computer.  Print from moving trace or 
traces frozen with the STOP/START switch. 

 

 

PC-Display Software   
The Windows application program installed on your computer for the software processing and 
display of  real time ECG and temperature (when an esophageal probe is used) information.  This 
software can be installed on multiple computers without limit and simultaneous instances of  the 
program can be run on a single computer subject to computer capability and the type of  display 
used.  NOTE:  A large, flat panel display can be plugged into your computer for greater 
visibility. 
 

Reviewer Software 
The Vmed Reviewer program is used to open and review patient files saved from PC-
Display.  The Reviewer program is compatible with PC-Vet and PC-VetGard+ patient 
monitors.  Refer to Chapter 4 for a complete description of this program. 

 

 

 



 

 27272727    

Interpreter Software 
The Vmed Interpreter is an optional ECG interpretation program that performs all the 
functions of the Reviewer program in addition to computer interpretation of ECG 
complexes.  
 

Windows Display 
NOTE:  To ensure that the entire screen is displayed, set the computer screen 
resolution to 1024 x 768.  You can do this by selecting the CONTROL PANEL > 
DISPLAY > SETTINGS tab. 

  

 
 

 

Figure 5  PC-Display showing  PC-Vet information. NOTE:  Temperature is only displayed when an 
esophageal probe is being used. 



 

 28282828    

 

Sweep and Scale   

 

Sweep:  Sweep moves across the display from left to right at the selected sweep speed.  
Default sweep speed is 25 mm/sec, which is preferred for monitoring.  The sweep color is 
magenta if leads off or with poor electrode-patient contact and green with good electrode-
patient contact.  If the sweep is magenta, an ECG waveform may appear however a heart rate 
will not be displayed.  

Vertical Scale:   The vertical scale of the display and the print report measures signal 
amplitude.  When gain is set at 1, the signal amplitude of 1mV has a vertical scale deflection 
of 10 mm by convention. A 1mV reference mark appears on the display and print report. 
Vertical scale deflection increases by a multiple of the gain and the 1mV reference mark also 
increases proportionately. 

CAUTION: Grid spacing does not change with change in gain setting.   Use 
amplitude reference marker (1mV) to estimate amplitude of ECG signals on the 
screen.  

 Horizontal Scale:   Time is measured on the horizontal scale and marked on the 
 display and print report every second.  

 

Display Toolbar 
 

  SWEEP            MARK         SELECT          SILENCE      DISPLAY        ENTER           OPENS ECG REVIEWER     ABOUT 
  RATE          R-WAVES        TRACE           ALARM    TREND       PATIENT       OR INTERPRETER              SOFTWARE 
                                                 

              

 

 

                                                                
     

           

SELECT         ECG           R-WAVE    CHANGE       DISPLAY       RECORD         PRINT           START/ STOP    REFERENCE 
  GRID        GAIN         AUDIO   SETTINGS       ALARM            ECG          REPORT             TRACE                    MARK 
         

       

                       
Figure 6  PC-Display toolbar       
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Function Options  
 

1. Turn on the PC-Vet and establish connection to the computer. 
 
2.  Press the SELECT switch on the PC-Vet keypad and the following menu appears: 

 

       

 

3.  Use the UP/DOWN switches on the PC-Vet keypad to select the function and then 
the press the SELECT switch to choose the option.  Repeat the process for each 
function.  NOTE:  These functions may also be selected from the PC-Display toolbar or menus. 
 
4.  Highlight "EXIT" and press the SELECT button to close the window after all choices 
are made. 

 

 

 

 

 

 

 

 



 

 30303030    

 

Default Function Settings  
 

NOTE:  Refer to Chapter 1 to change default values for each function and for 
input of vet/clinic and patient information. 

  
  

SELECT OPTIONS DEFAULT 

Silence Alarms Press to silence audio 
alarm 

Keypad & Toolbar 

Species Canine Gain 1 

 Feline Gain 1 

 Equine Gain 1 

 Other Gain 1 

Sweep Rate 25 mm/sec  

 50 mm/sec 50 mm/sec 

 100 mm/sec  

Gain 0.5: 55 mm/mV  

 1.0:  10 mm/mV 1.0:  10 mm/mV  

 2.0:  20 mm/mV  

 3.0:  30 mm/mV  

 4.0:  40 mm/mV  

R-Wave 
Marker 

ON 
OFF 

 
OFF 

   

Grid ON  

 OFF OFF 

Beat Tone ON  

 OFF OFF 

Record ECG Press for continuous 
Reviewer recording 

Keypad & Toolbar 

Alarms ON  

 OFF OFF 
 

  Table 1   “Select” key options and factory default values      
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Chapter 3     Operating Instructions 

Preparation 

 
PROCEED ONLY AFTER YOU HAVE SUCCESSFULLY INSTALLED THE SOFTWARE 
AND HAVE COMPLETED THE BLUETOOTH DISCOVERY PROCESS. 

 
     

1. Plug the sensor of  choice into the appropriate PC-Vet receptacle.  

2. Double-click the PC-Display icon on your desktop to start the program.  This will 
open the PC-Display application and present you with the Connection window.   

3. Turn on the PC-Vet by briefly depressing and releasing the red “ON/OFF” power 
switch on the keypad (Do not hold the power switch down).  The “STATUS” light 
will turn red and then amber. 

4. Select your PC-Vet from the list in the Connection window and then click the 
“Connect” button. 

5. Input patient information (Vmed recommends at least entering information into the 
Patient Name box) and then click the “OK” button. 

6. Wait for the “STATUS” light to turn from yellow to green. The process may take as 
long as 30 seconds to complete the first time after initial discovery. 

7. When the PC-Vet status light turns green, the notation in the STATUS box on the 
screen will change to “Connected” and the notation at the lower right corner of the 
screen will change to: “PC-Vet Remote Connected” on a green background. 

  
NOTE: To preserve battery life, the PC-Vet will shut off automatically if 
connection to your computer is not established within 3 minutes of powering 
on the remote. 
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When connection is complete, the sweep appears on the display as a flat magenta 
colored line moving left to right at the selected sweep speed.  Upon acquisition of a 
satisfactory signal, the waveform will appear and the trace will change to a color 
corresponding to the sensor: 
 

   Green:   Good ECG signal 
   Magenta:   ECG Leads Off or poor signal quality 
   White:   (DIGITS ONLY):  TEMPERATURE   
  

NOTE: A magenta ECG sweep represents a Leads Off condition and may 
occur even if a waveform is present, however the computer will not 
recognize a valid ECG and the digital heart rate display will not appear.  
You should, in this case, reposition the sensor or clip leads until a green 
sweep appears.  

 

Taking the ECG 

Important comments on ECG    

The PC-Vet obtains two types of clinical ECG information (l) rate and 
rhythm and (2) QRSP and T characteristics.  For surgical and long term 
monitoring, rate and rhythm only is needed to monitor patient status since 
changes in heart rate or significant variation of the periodic interval of the 
beating heart may be indications of patient compromise.  Accurate Rate and 
rhythm can be obtained by any of the available sensors provided with the PC-
Vet, leg clips and the internal positioned esophageal probes being the most 
often used in surgery.  For long term patient monitoring, leg clips or 
disposable chest electrodes may be used with the optional clip leads.  
 
Accurate diagnostic lead II ECG, on the other hand, requires information on 
both the rate and rhythm of the heart and evaluation of the ECG complexes 
themselves.  Conductive abnormalities, for example are manifested by higher 
than normal R and S amplitude.  For routine ECG and pre-surgical screening, 
the chest sensor is most convenient and is recommended for this application, 
however the method may produce inaccuracies in amplitude if the chest probe 
is not positioned at the correct angle to the heart.  For this reason, whenever a 
beat characteristic or signal amplitude seems abnormal when using the chest 
sensor, a follow up trace should be taken using the leg clips to confirm the 
reading.    
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Recording ECG Waveforms 

The default setting for recording information through PC-Display is the “Continuous Event” 
setting.  This means that only alarm events, printing events, marker events or the periodic 
vital signs events will be recorded without any ECG waveform information.  In order to 
record ECG waveforms in addition to these events you would need to click the “Toggle 
Continuous ECG” button from the PC-Display toolbar.   

       

Figure 7 Toggle Continuous ECG Button (Disabled and Enabled) 

Clicking once on this button will enable this recording mode and will put a checkmark in the 
bottom right corner of the button itself to show that it is enabled.  Clicking it again will 
disabled this recording mode and close the episode file that was just recorded to.   

Additionally, if the “Auto Save” feature in the Default Configuration screen is selected then 
the Continuous ECG recording mode will be enabled from the point of connection to the 
PC-Vet.  In other words, all information (including ECG waveform) will be recorded 
automatically as soon as the PC-Vet is connected until the Continuous ECG mode is disabled 
or the PC-Vet is disconnected. 

Using Chest Probe 

1. Place the patient in the right lateral recumbent position and pull the front legs cranial. 

2. Liberally apply alcohol or electrolyte solution to the left lateral chest wall where the 
electrodes will make contact. Position the chest probe over the heart, and press firmly 
enough that all three electrodes make good contact with the body wall.  

  

 

Figure 8  Position of the ECG chest probe for rhythm strip 
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3. Rotate the probe until the “R” amplitude is at its highest and a good tracing appears on 
the screen.  If a good tracing is not obtained, re-saturate the chest wall with more 
electrolyte and reposition the chest probe. In some cases excess hair should be clipped. 
NOTE: To obtain a printable waveform, the trace must be green not magenta.  
Magenta signifies a Leads-Off situation even if a waveform is present. 

4. Record the ECG until three good lines of tracing appear on the screen.  NOTE:  The 
four panels stacked vertically on the display represent a continuous trace with 
the earliest information being replaced by the current sweep. At the default 
chart speed of 50 mm/sec, the four panels represent 16 seconds of data.  

5. Depress the Start/Stop button on the chest probe or on the PC-Vet keypad to stop 
the trace.  Depress the Print button on the keypad to print this display and to 
automatically save it to the Reviewer program.  You may also print directly from the 
moving trace by pressing the PRINT switch on the keypad. 

NOTE: Any time the Print function is called within PC-Display there will be a 
30 second recording of the ECG waveform automatically saved unless the 
current recording mode is already Continuous ECG.  The Start/Stop button is 
not required for printing and will make no difference for recording.  It is there 
simply to freeze the real-time display in order for the user to have a better view 
of it. 

 

Using Leg Clips 

The three lead clips are color coded according to American Heart Association (AHA) standards. 
The following table provides the list of  AHA color codes for Lead II connections modified to 
identify animal legs. 

 

LEAD BIPOLAR LEAD & REFERENCE COLOR 

II RF-Right Front Negative Electrode White 

 RH-Right Hind Reference Green 

 LH-Left Hind Positive Red 

 

Note:  For an accurate Lead II reading, each pair of legs must be parallel to 
one another but not touching.  Use standing or right lateral recumbency. 

 Plug each clip lead wire into the appropriate receptacle of the matching color on the 
 connecting cable yoke. 

1. Plug the connecting cable into the PC-Vet receptacle. 

2. Place animal in the right lateral recumbent or standing position. 
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3. Saturate the area where clips attach with alcohol or electrolyte. 

4. Connect leg clips according to the color coded designation stamped on the connecting 
cable. Connect two clips to the hind legs, Red to left hind and Green to right hind, on 
the posterior aspect of the leg just proximal to or distal to the point of the stifle. 
Connect the remaining clip, White to the right front leg on the anterior aspect of the 
leg just proximal to or distal to the elbow. 

  

Using Esophageal Probe 
 

Choose the correct probe for the appropriate size of animal.  If the baseline tends to 
wander or deviate from a straight line, the electrode spacing is too large and a probe with 
a shorter spacing should be used.  If the ECG signal is intermittent, usually with 
respiration, the electrode diameter is too small for the animal and a probe with larger 
diameter electrodes should be used.  NOTE:  Do not try to evaluate ECG traces 
using the esophageal probe.  The sweep is accurate for rate and rhythm 
information only.  Use the ECG clips for a Lead II ECG. 

  

1. Lay the probe on the animal simulating its position in the esophagus. 
 

2. Place the end of  the probe one finger width from the last rib. 
 

 

 

Figure 9  Position of optional esophageal probe 

 3.  Note the distance marked on the probe in centimeters at the nose. 

4.  Slide the probe into the esophagus until the distance marked at the animal’s nose is 
at the mouth. 

 5.  Move probe cranial and caudal until the best heart signal is obtained. 
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Using Long Term Monitoring Electrodes 

  
The clip leads provided with this optional sensor connect to the metal tabs on disposable 
infant pre-gelled electrodes.  Disposable chest electrodes are best for long term, critical 
care situations when the animal is under or recovering from anesthesia. It may be 
necessary to shave excess hair. 

 
1. Plug the three clip leads into the corresponding colored receptacle on the yoke cable. 
 
2. Connect clips to each of three electrodes. 

 
3. Prepare the electrode site by clipping excess hair.  

 
4. Wet area with alcohol and wipe dry. 

 
5. Remove electrode from the liner and place on the leg indicated by the color code on 
the cable preferably above the hock and elbow. Electrodes may also be placed on the 
chest, over the heart and oriented to the Lead II axis:  White on right chest toward 
right front leg, Red in the middle and Green on left chest toward the left back 
leg.  NOTE:  It is suggested that a protective bandage be applied over the electrodes to prevent the 
animal from dislodging or chewing off the electrode or lead. Accurate Lead II information is only 
available if electrodes or clips are attached to the patients’ legs. 

 
6. Smooth down the electrodes with a circular motion.  Avoid pressing on center of 
electrode. 
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PC-Display Keyboard Shortcuts 
  

PC-Display has several keystroke combinations that you can use to quickly access certain 
functions using the computer’s keyboard.  Most of these keystrokes involve a combination of 
keys being pressed at the same time.  For instance, “Alt+H” denotes that the “Alt” key and 
the “H” key should be pressed at the same time to achieve the desired results.  Likewise, 
“Cntl” denotes the Control key. 

 
Keystroke Action Description 

Alt+C Connect Wireless Remote Toggles between PC-Display trying to connect to a remote or not.  
NOTE: When PC-Display is not trying to connect the “Edit Default 
Configuration” option is enabled beneath the “Tools” menu. 

Cntl+I Edit Patient Information Opens the window allowing the user to edit the current patient’s name or 
ID, client name, species, breed, age, sex and weight.  If the session is 
being recorded then this recorded episode will reflect any changed values. 

Cntl+N New Patient Opens the window allowing the user to input the next patient’s name or 
ID, client name, species, breed, age, sex and weight.  This will begin a new 
episode if the current session is already recording. 

Cntl+P Print Opens the print dialog window allowing the user to print the last 30 
seconds of the current ECG strip (this same strip will be recorded into an 
episode as well). 

Cntl+G Show Grid Toggles the grid behind the ECG waveforms on or off. 

Cntl+M Show R-Wave Marker Toggles the triangular R-Wave markers that appear above each detected 
R-Wave of the ECG waveform on and off. 

Cntl+T Show Trend Graph Opens the Trend Graph window. 

Alt+S Set ECG Sweep Speed Allows the user to select which sweep speed to use for the ECG 
waveform. 

Alt+G Set ECG Gain Allows the user to select which gain to use for the ECG waveform. 

Cntl+E Edit Current Configuration Opens the configuration window allowing the user to edit many of the 
parameters of PC-Display’s current session without disconnecting the 
remote. 

Cntl+Q Enable QRS Tone Toggles on or off the tone made for each heart beat. 

Cntl+A Enable Alarm Tones Toggles on or off the tones made when an alarm limit has been exceeded.  
This can essentially act as a “silence alarm” feature. 

Alt+A Enable Alarms Toggles on or off the alarm limits for all values. 

Alt+R Review Stored Episode If a complete episode has been recorded in the current session then this 
will open the “Wireless Remote Review Episode” window. 
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Keystroke Action Description 

Cntl+R Record Patient Data Toggles on or off the recording of patient data to a stored episode. 

Alt+P Play/Halt Toggles on or off the progression of waveforms on the screen (similar to 
freezing or unfreezing the current display). 

Alt+M Mark Event Places an orange triangular mark at that moment on the ECG waveform 
for later reference.  Additionally, if an episode is not already being 
recorded this will record a brief episode with the mark listed as an event. 

Cntl+H About PC-Display and Remote Opens the About window for PC-Display.  If a remote is connected at 
the time then this window will also display the built-in parameters of this 
remote. 

? View Manual Opens an online version of the user’s manual in a web browser. 

 
 
 

Printing Records  

Once you have recorded a satisfactory ECG trace you may print the information directly 
from the PC-Vet keypad or later from the Reviewer or Interpreter programs provided the file 
was saved first.  

 TO PRINT REPORT 

 1.  From the PC-Vet keypad:  Press Print, or… 
 2.  from the display upper tool bar:  Click the print icon, or… 

 3.  From “File” choose print. 

 4.  Select “Scale to fit” or “shrink to fit” on the printer setup dialog box. 

NOTE: Printing from the screen requires wireless connection between the PC-
Vet and your computer. In other words, you can only print from the screen 
when there is an active connection between the PC-Vet and your computer.   
Printing from saved and recalled files does not require a wireless connection. A 
color printer is required to reproduce the colored grid.  

4. Save reports to a PDF file by selecting ”Primo PDF” in the “Print to” drop down 
box in the print dialog window (this first requires the installation of the Primo PDF 
software).        
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 Figure 10  Computer’s print dialog box 
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Figure 11  PC-Vet print report [Note signal amplitude (1 mV) reference scale and time reference points on 
horizontal axis].  Temperature readout requires use of esophageal probe. 
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Chapter 4     Reviewer Program 

    Description 
NOTE:  Files may also be opened with the optional Vmed Interpreter program if installed.  Select the 
program you wish to open files with in the PC-Display configuration menu under “Tools”. 
 
The Vmed Reviewer program is included with each Vmed wireless monitoring product 
and is also available free to any interested person in order to facilitate ECG interpretation 
by third party consultants.  The Reviewer program performs the following functions: 
o Displays the recorded patient files where information recorded from Vmed 
wireless monitoring products may be stored automatically. 

o Allows archived ECG sweep, patient and episode data to be recalled for review, 
editing, measurement and printing. 

o Provides for the electronic measurement of ECG complexes. 
o Allows real-time playback of previously recorded ECG sweep data. 
o Makes available, through the Help menu, a table of normal ECG measurements 
for cats and dogs and guidelines for measuring ECG complexes. 

o Provides an easy method of summarizing and storing ECG measurements, vital 
signs and diagnostic notes. 

o Provides and easy way of sending email transmission of stored reports. 
o Displays the automatically recorded periodic vital signs measurements. 
 

Modes of Monitor Recording 
ECG and related data are stored automatically in one of three available modes.  Record 
modes are selected in the PC-Display Configuration window: 

 
1.  Continuous event recording (typically used in surgery monitoring) 
o Records vital signs only on event (Print command, alarm activation, or change 
of record mode). 

o Does not record ECG sweep 
o Records Vital signs periodically as selected in the PC-Display configuration 
window. 

NOTE:  This is default mode for PC-Vet 
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2.  Event Initiated ECG Sweep Recording (Typically used in ECG exams) 
o Vital signs and 30 second ECG sweep are recorded on event (Print command, 
alarm activation, vitals recording or marker). 

 
3.  Continuous ECG Sweep Recording (Typically used in long-term monitoring) 
o Continuous recording of ECG sweep and event initiated vital signs for the life 
of the batteries (about 50 hours). 

o Activated with the “Toggle Continuous ECG” button on the PC-Display 
toolbar. 
NOTE: This mode selection overrides and supersedes any previously 
selected mode. 

 

Using the Reviewer Program 
1. Double-click the Reviewer icon on the desktop and the Reviewer window will 

open. 
2. Click “File” then “Patient episode” on the upper toolbar and the window 

below will open: 
 

 

NOTE: If a patient is not pre-identified, patient files are stored numerically by 
year, month and day.  Patient data can be entered prior to, during, or after the 
monitoring procedure and edited within the Reviewer. Episodes are identified 
by date and time of the event. When “ECG” follows the episode ID, this 
indicates that an ECG sweep is present rather than just vital signs.  
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3.  Highlight the patient of interest and then the episode of interest for that patient as 
shown above and press OK.  The next screen will appear: 

 
  

 

NOTE:  This screen summarizes the patient file for the episode selected along 
with cursor measurement of the QRS complex. The measurements selected 
have been dropped into the diagnostics notes and comments box. Note the 
“red rubber band” vector and the measurement crosshairs above.  

Using the electronic cursor measurement feature 

1. First click on the complex you wish to measure in the “Measurements” box at the 
top of the screen.  Note: For a description of each complex, click on the “Help” 
menu in the upper toolbar. 
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2. Next, left click the mouse at the beginning point of your measurement, then drag 
the mouse to the right and up if amplitude is to be included (you can measure both 
time and amplitude by measuring at a diagonal).  Note the red rubber band in the 
above illustration. Place the blue crosshair at the end of the interval and the top of 
the amplitude and release the mouse button.  The one step measurement will result 
in an interval and amplitude calculation if appropriate for that complex.  NOTE: 
For best accuracy, increase the gain of the signal before beginning the 
measurement procedure. 

 
3. Repeat the procedure in step 2 for each type of measurement. 

4. Click the “Copy to Diagnostic Notes” button to drop your measurements into the 
diagnostics notes section of the report. 

 

Reviewer Upper Tool Bar  

     2           4                6                   8                10       12           14                16    18     20 

 

 

  
      
       1            3   5        7          9            11 13    15      17         19           21 

 
 

           22              23 

 
Icon Descriptions 

 
1. Open episode 
2. Save episode 
3. Save copy of episode 
4. Email episode 
5. Configure Reviewer 
6. Cut 
7. Copy 
8. Paste 
9. Print 
10. Shift ECG baseline up 5mm 
11. Shift ECG baseline down 5mm 
12. Reset baseline   
13. View “R” wave markers 
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14. Play ECG view 
15.  Pause ECG view  
16.  Skip to beginning of ECG trace 
17.  Skip ECG view backward 
18.  Skip ECG view forward 
19.  Skip to end of ECG trace 
20.  View vitals events only 
21.  About Reviewer 
22.  Select chart speed 
23.  Select gain  
 

Reviewer Configuration 
To configure different options within the Reviewer software click on the “Configure 
Reviewer” toolbar button or select “Configure Vmed Reviewer…” from the Tools menu.  
The following window will appear. 
 

 
 

 
� Patient Episode Directory:  Allows you to select the directory where patient 
files are stored as recorded in PC-Display.  This location must be the same as 
that selected in PC-Display.    
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� Saved Episode Directory:  Patient Episode files by default will be saved in 
this directory when the “Save copy of episode” option is chosen. This can be 
very helpful if you prefer to frequently save episode copies into the directory of 
a network computer.  

 
� Default ECG Strip Grid Color: You can change the color of the grid on the 
Reviewer screen.  This also changes the color of the print report grid.  

 
� Set Reviewer as the default episode viewer:  This will cause PC-Display to 
associate Vmed patient episode files with the Reviewer software (instead of the 
Interpreter software – only necessary if the Interpreter software is installed and 
Reviewer is preferred). 

 
� Default Veterinarian Information:  Uses (for printing) the vet clinic 
information entered here instead of what was recorded with the original 
episode.  Select Edit Default Veterinarian Information to change. 

 
� Default CO2 Waveform Scale:  Used for PC-VetGard+ only. 

 
Manage Patient Episodes Directory 
Selecting this choice opens the screen below: 

 

 
  

The “Manage Patient Episodes” screen allows you to remove unwanted patients and 
episodes.  To delete a patient, highlight the patient and press the “Delete Patient” 
button.  To delete an episode, highlight that episode and press the “Delete Episode” 
button. NOTE: to delete episodes, you must first highlight a patient and then 
highlight the episodes to be deleted. 
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Printing 
In order to print an episode either select “Print…” from the File menu or click the printer 
button on the toolbar.  If printing the ECG waveform then one page worth of ECG 
waveform will be printed (the number of seconds depends upon the sweep speed selected).  
The following window will open when the print command is initiated allowing you to make 
your selection: 

 

    

Below is a sample printout where the first page is the ECG Waveform Report and the second 
page is the Event Summary Report. 
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Figure 12  Default ECG Waveform Report includes hospital and patient information followed 
by twelve seconds of ECG waveform. 
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Figure 13  Default Event Summary Report includes vital signs, measurements and clinical 
comments. 
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Help Menu   
The following selections are available under the “Help” menu: 
 

• Internet Support Website:  Hyperlinks to the Vmed service website. 

• Background on ECG Waveform Measurements (shown below) 
 

 
Figure 14  Instructions for measuring ECG complexes from the “Help” menu 
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• Display Canine ECG Normal  Measurements 
 

 

Figure 15  Table of Normal ECG measurements for canine patients from the “Help” menu.    
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• Display Feline ECG Normal Measurements 
 

 
 
Figure 16  Table of Normal ECG measurements for feline patients from the “Help” menu     

Information in Figures 13, 14 and 15 are from Electrocardiography for the Small 
Animal Practitioner, Larry P. Tilley, DVM, DACVIM (Internal Medicine), Naomi 
L. Burtnick, MT (ASCP).  “Made Easy Series”, Teton New Media. 
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Chapter 5     Service and Maintenance 

Service and Support  

If you purchased directly from Vmed: 

Phone: 800-926-9622 
FAX:  424-585-0231 
Email:  info@vmedtech.com  
WEB:  www.vmedtech.com/customers  (current manuals and software updates) 
 

 

If you purchased from DVM Solutions or your dealer:  

Phone:  866-373-9627 
FAX:   830-438-7041 
WEB:   www.dvmsolutions.com  

 

Cleaning 

Clean the PC-Vet, sensors and cables by wiping surfaces with any of the following 
solutions: 

• Soap and water 

• Alcohol or alcohol/disinfectant mixture 

• Peroxide solution 
 

Precautions 

• Do not immerse or soak the PC-Vet or cables and sensors in any liquid 

• Do not use petroleum based solvents 

• Do not steam autoclave 

• Do not gas sterilize the PC-Vet or sensors 
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Maintenance 

 
There are no field serviceable components inside the PC-Vet.  Opening the housing (exluding 
the battery compartment) voids the warranty.  Store the PC-Vet in the storage pouch when 
not in use. 

Changing Batteries 
 

To change the two AA batteries, press and slide open the battery compartment lid on the 
back of  the PC-Vet housing.  Batteries are easiest removed by slapping the bottom of  the 
PC-Vet against the palm of  the hand until the batteries are dislodged and fall into your 
hand as shown below.  Note polarity when replacing batteries.  Insure that each new battery 
makes proper spring contact and is pushed all the way into the bottom of  the battery 
compartment. 

 
 

             
 
 
  

Cable Connectors 
Sensor plugs should be inserted into the receptacle by pushing straight into the 
opening while grasping the plug.  Do not remove by pulling on wire.  NOTE: the 
Vmed logo is on the top and the plug key is on the bottom. 
 
Troubleshooting 
 
Refer to the table on the next page to trace common problem areas. 
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Troubleshooting 
 

SITUATION POSSIBLE CAUSE CORRECTIVE ACTION 

Cannot make Bluetooth connection 
with computer. 
 
 
 

• Weak batteries in wireless device 

• Improper Bluetooth discovery. 

• Bluetooth device not inserted into USB 
port. 

 

• Replace with two new  AA batteries. 

• Re-initiate discovery procedure. 

• Verify that USB Bluetooth adapter is 
plugged in to computer. 

• Determine if the Windows XP Service 
Pack 2 method of Bluetooth should be 
used over Bluetooth drivers that came 
with Bluetooth adapter. (See Chapter 1) 

Bluetooth connection has range <50ft. • Low Batteries. 

• Signal must pass through high attenuation 
barrier such as concrete floor/walls or 
heavy metal objects. 

• Using built-n Bluetooth with 10 meter 
range. 

• Replace both batteries. 

• Clear signal path. 

• Disable computer’s built-in Bluetooth and 
use the Bluetooth device provided with 
wireless product. 

Cannot acquire satisfactory ECG 
signal 

• Not enough electrolyte fluid used. 

• Not making adequate skin contact. 

• Corroded electrodes. 

• Broken or corroded lead wire, cable or 
plug. 

• Bad cable connection. 

• Re-apply electrolyte. 

• Re-position electrodes and clip excessive 
hair. 

• Replace electrodes. 

• Replace lead wire or cable. 

• Remove and re-insert all plugs. 
 

Excessive noise in the ECG signal • Inappropriate filter selected. 

• Poor electrode-skin contact. 

• Excessive motion. 

• GAIN set too high. 

• RFI or electromagnetic interference. 

• Change filter from “Low” to “High” in the 
“Tools” drop down menu. 

• Re-apply electrolyte and re-position 
electrodes. Reduce patient motion. 

• Set GAIN to 1. 

• Shut off electrical devices near PC-Vet 

Lost wireless connection with 
computer 

• Wireless device out of range of computer 
or behind signal attenuator. 

• Wireless device lost power. 

• Bluetooth device loose in USB port. 

• Computer turned off or PC-Display 
closed. 

• Move toward computer or clear 
attenuating obstacle. 

• Recycle wireless device power switch 

• Check /Replace Batteries  

• Check Bluetooth device/USB connection. 

• Re-start PC-Display program.  

Cannot turn wireless device unit back 
on. 

• Batteries are totally discharged. 

• User is pressing and holding power button. 

• Replace batteries. 

• Press and immediately release the power 
button to turn on. 
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Appendix A     Computer Requirements and Specifications 

Computer Requirements 

• >200 MHz. PC desktop, laptop or tablet computer  

• Windows  Vista, XP or 2000 operating system (XP or Vista recommended) 

• 32 MB RAM 

• SVGA display, 256 colors, resolution set to 1024 X 768 

• Spare USB 1.1 (or later) port 

• CD Rom Drive 

• 30 MB available hard disk space for PC-Vet program, plus approximately 10 Kbytes per patient 
stored 

• Windows supported printer 

• MAPI compliant E-Mail system such as Microsoft Outlook or Outlook Express. 
  

Physical Specifications 
 

TYPE:  Three lead ECG with integrated Bluetooth wireless module 
CONSTRUCTION:  High impact ABS plastic with over-molded sides. 
DIMENSIONS OVERALL 

 LENGTH:          6.0” 
 WIDTH:         3.75” 
 THICKNESS:           1.1” 

WEIGHT (WITH BATTERIES)        7.4 oz. 
CONTROLS:  FLAT PANEL KEYPAD SWITCHES, TACTILE PUSH TYPE:   

ON/OFF  
SELECT  
UP/DOWN ARROWS 
STOP/START 
EVENT MARK 
PRINT  
INDICATORS:   
STATUS LED 
REPLACE BATTERIES LED 

CABLE CONNECTION:  Circular mini-DIN, 6 pin. 
BATTERIES: 

  TYPE:  AA Alkaline, Long life or rechargeable 
  QUANTITY:  2 
  BATTERY LIFE: >50 hours continuous operation 
 PATIENT CABLE AND LEADS: 

36” or 80”ZIP cable with three clips attached  
Three electrode chest probe with 32” cable and connector 
Optional three electrode large animal chest probe 

 Optional 3 receptacle yoke cable for patch-on electrodes 
 Opional esophageal probes with 36” cable 
 
 

Appendix A 
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System Specifications 
 

ECG GAIN/SENSITIVITY:  5, 10, 20, 30 mm/mV 
COMMON MODE REJECION: -70dBV CMRL 
SAFETY STANDARDS:  IEC 601, AAMI EC-11 
INPUT IMPEDANCE:  1 M Ohm 
INPUT DYNAMIC RANGE:  15 mV 
DC OFFSET CORRECTION:  -0.5 Hz. 
A/D SAMPLING RATE:  500 Hz. 
SAMPLE RESOLUTION:  12 bit 
ECG SWEEP SPEED, SELECTABLE:  25, 50, 100 mm/sec. (Default: 50 mm/sec.) 
QRS DETECTION RANGE:  >0.2 mV  
FILTERS: 

 PERMANENT:  Pass Band:  High pass:  70 Hz 
     Low pass:   40 Hz 
 USER SELECTABLE:  Notch (AC line noise rejection): 50/60 Hz 

ALARMS: 
  HEART RATE: High/Low, selectable limits 
  TEMPERATURE:  Low limit selectable with auto step-down 

FEATURES: 
  ALARMS:      ON/OFF 
  TONE:      ON/OFF 
  GRID:       ON/OFF 
  ALARMS:      ON/OFF 
  R-WAVE DETECTOR: ON/OFF 
  EVENT MARK:  USER ACTIVATED 

WIRELESS:  Bluetooth Class I radio (100 meters line of sight range) 
  RANGE:  50-100 ft. in practice (100 meters line of sight) 
  FREQUENCY:  2.4-2.4835 GHz 
  OUTPUT POWER:  4 to 20 dBm 
  PHYSICAL INTERFERANCE:  USB UHCI/OHCI 1.1 compliant 
  MANUFACTURER:  As selected by Vmed 
   

PC SYSTEM REQUIREMENTS: 
  CPU: Windows compatible computer, 500MHz or > 
  Memory:  Min 256 MB, 512 MB recommended 
  USB port:  One available, USB 1.1 standard 
  Operating Systems: 2000, XP or Vista 
  Audio:  Any Windows audio hardware and speakers 
  Video:  32 MB video RAM, 64 MB recommended. 
   Resolution:  1024 x 768   
   Software Color Profiling:  Disabled 
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Appendix B     Warranty 

Vmed Technology warrants that the PC-Vet ECG monitor to be free of defects 
in material and workmanship for a period of TWO YEARS from the date of 
purchase by the original end user customer.  ECG sensors including cables, lead 
wires and connectors sold with the PC-Vet or purchased as an optional 
accessory, are warranted for a period of SIX MONTHS from the date of original 
purchase.  If in the judgment of Vmed Technology, the PC-Vet or accessories are 
proven to be defective during the warranty period, they will be repaired or 
replaced with no charge for parts or labor.  

This warranty does not cover consumable supplies or products damaged by 
accident, abuse, or misuse or products altered or repaired by anyone other than 
Vmed Technology or its designated repair agents.  OPENING THE PC-VET 
HOUSING WILL VOID THE WARRANTY. 

This warranty is exclusive and is in lieu of all other warranties whether expressed 
or implied including warranties of merchantability and fitness for a particular 
purpose.  The obligations under this warranty are limited to repair or 
replacement. 

A return authorization number is required before returning any product for 
warranty or non-warranty repair. Products or parts shipped to Vmed for warranty 
service must be shipped prepaid and insured via a carrier that provides package 
tracking such as UPS or FedEx. Vmed will pay the return freight on products 
repaired under warranty.  
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